Design-in guide

Xitanium LED Programmable Drivers (75W & 150W) for outdoor use
Version 2.0

PHILIPS
sense and simplicity
# Contents

1. Introduction 3

2. Xitanium LED Programmable Driver Features 4
   2.1 Driver Wiring 4
   2.2 Adjustable Output Current (AOC) 4
   2.3 Window of Operation 5
   2.4 Constant Light Output (CLO) 5
   2.5 Over The Life (OTL) 7
   2.6 Adjustable Startup Time 7

3. Driver Specifications 8
   3.1 Input Voltage Range 8
   3.2 Driver Output Current, Range and Tolerance 8
   3.3 Power Factor (pf) 8
   3.4 Total Harmonic Distortion (THD%) 8
   3.5 Efficiency 9

4. Thermal Considerations 10
   4.1 LED Module Thermal Protection (MTP) 10
   4.2 Thermal Fold Back (TFB) of Driver 10
   4.3 Temperature Case Point 11
   4.4 Lifetime 11
   4.5 Reliability and Failure Rate 12

5. Dimming 14
   5.1 Programmable Dimming Options 14
      5.1.1 1-10V Dimming Interface 14
      5.1.2 Dimming Through DALI 14
      5.1.3 Integrated Dynadimmer 15
      5.1.4 Dyndimmer Override 15
      5.1.5 AmpDim 16

6. Inrush Current 17

7. Surge Protection 18
   7.1 Protecting LED Drivers in Accordance with
      IEEE / ANSI C62.41.2 Transient Surge Requirements 18
   7.2 Choosing the Correct Suppression Device 19
      7.2.1 What to look for in the MOV ratings 19
      7.2.2 Connecting the MOVs in the fixture 19
   7.3 Why not design a Driver to survive 10kV directly without clamping to earth ground? 19

8. Leakage Current 20

9. Electromagnetic Compatability (EMC) 20

10. Electrical Isolation 20

11. IP Rating 21

12. Programming 22
   12.1 Frequently Asked Questions 22

13. Profiles 25
   13.1 Saving a Profile 25
   13.2 Loading a profile 25
   13.3 Selective Programming 26
   13.4 Version Management 26
   13.5 Factory Programmer 27

   14.1 Synchronization to Change in ON-Time Duration 28
      9.1.1 Case 1 28
      9.1.2 Case 2 28
   14.2 Scenario 1: Input Mains Power Interruption 28
   14.3 Scenario 2: Input Mains Power Dip 28
   14.4 Scenario 3: Input Mains Power OFF for Maintenance or Temporary Power Outage 29
   14.5 Scenario 4: Programming a New Dimming Schedule 29

15. Electrical Isolation 20

16. IP Rating 21
1. Introduction of Xitanium LED Programmable Drivers

Thank you for choosing Xitanium Programmable Drivers.

Rapid improvements in high-power LED technology mean that LEDs can now be driven, dimmed and managed in common lighting applications, providing improvements over traditional lighting systems.

With advances in LED technology, LED efficacy and current capability is advancing rapidly. To keep up with this rapidly advancing technology, drivers have to be designed and re-designed to supply the appropriate current/voltage to deliver the required light output. Xitanium Programmable Drivers provide a unique solution where nominal driver current levels can be programmed (either through a simple programming interface or via an external resistor), thereby allowing the same driver to be easily used in multiple applications.

In addition, Xitanium LED Programmable Drivers benefit from the integration of several different dimming features. With the capability to incorporate multiple dimming schemes in a single driver, users in different regions of the world can select a dimming interface based on its popularity and availability in their respective region. Also, it allows the user to query driver status via DALI while simultaneously allowing analog dimming via 1-10V. This Prog+ version of the driver also includes a new feature, AmpDim which enables cabinet-based intelligent dimming without the need for additional control wires or infrastructure changes.

This guide tells you all about Xitanium LED Programmable Drivers. If you require any further information or support, please contact your sales representative.
2. Xitanium LED Programmable Driver Features

2.1 Driver Wiring

![Driver wiring image]

Figure 1: Driver lead wire color code definition

![Diagram of LED driver connections]

2.2 Adjustable Output Current (AOC)

LED technology is rapidly evolving with more efficient (higher lm/W) LEDs being available. Hence the same light output can be achieved with lower currents. At the same time, LEDs can be driven at different current levels based on the application requirement. Typically, LED drivers are available in discrete current levels such as 350mA, 530mA or 700mA. It is often necessary to replace a specified driver when more efficient LEDs become available. The AOC feature enables OEMs to adjust the nominal current level of the LEDs. The user can likewise set any current between 200mA and 700mA in increments of 1mA. This can be achieved in two ways:

1. Via the external resistor (RSET) by placing an external resistor (min. 0805/125 mW/50 V) between the yellow and blue-white striped wires of the driver. The driver checks the value of RSET connected only at startup. If the resistor value is changed, the driver must be turned OFF and powered ON again for the new RSET value to take effect (Figure 2).

<table>
<thead>
<tr>
<th>RSET (Ohms)</th>
<th>Current(mA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>191</td>
</tr>
<tr>
<td>100</td>
<td>214</td>
</tr>
<tr>
<td>620</td>
<td>309</td>
</tr>
<tr>
<td>910</td>
<td>347</td>
</tr>
<tr>
<td>935</td>
<td>350</td>
</tr>
<tr>
<td>1500</td>
<td>406</td>
</tr>
<tr>
<td>2200</td>
<td>455</td>
</tr>
<tr>
<td>3000</td>
<td>494</td>
</tr>
<tr>
<td>4115</td>
<td>530</td>
</tr>
<tr>
<td>4300</td>
<td>536</td>
</tr>
<tr>
<td>8200</td>
<td>599</td>
</tr>
<tr>
<td>18000</td>
<td>649</td>
</tr>
<tr>
<td>100000</td>
<td>691</td>
</tr>
<tr>
<td>1000000</td>
<td>700</td>
</tr>
</tbody>
</table>

![Graph showing current vs. RSET]

2. Via the programmable interface (Figure 3).
2.3 Window of Operation

The 150W driver is designed to deliver 150W of LED output power. When delivering current from 200mA to 530mA, the driver can be used with an LED load from 125V to 280V. For currents higher than 530mA, or up to 700mA, the driver can be used with LED load based on Figure 5. For example, for current 600mA, the maximum allowed LED load is 250V (delivering 150W). For the 75W driver, the maximum output voltage is 152V at 500mA, while the maximum voltage is 115V for 700mA operation (Figure 4).

2.4 Constant Light Output (CLO)

Current traditional lighting sources (HPS, QMH and CMH) depreciate in light output during the life of the product. The CLO feature of the driver enables OEMs to create solutions with LEDs that deliver constant lumens through the life of the product. Based on the type of LEDs used, heat sinking and driver current, OEMs can estimate the depreciation of light output for specific LEDs and this information can be entered into the driver using the 16 point CLO interface. The driver counts the number of “LED module working hours.” As shown in Figure 6 at the left, each data point represents the LED module working hours threshold and the corresponding driver CLO percentage. The driver will increase current based on this input to enable CLO.

When the CLO feature is enabled, the driver nominal output current will be limited by the CLO percentage as shown by the relation below:

\[
\text{Driver target nominal output current} = \text{CLO percentage} \times \text{Adjustable Output Current (AOC)}
\]
For example, in the CLO profile shown in Figure 7, between 32000-36000 working hours, the CLO percentage is defined at 115%. (Assume the nominal AOC is set to 530mA). In this case, the maximum driver output current with CLO enabled will be $1.15 \times 530 = 610mA$. Figure 8 shows the effect of CLO on 1-10V dimming.

The CLO percentage can be set to a value between 10-120%, in increments of 1%. A value of 0% can also be entered, which can be used to turn OFF the driver at the end of rated life of the LED luminaire. The CLO LED module working hours can be any value between (0-127500 hours) in increments of 500 hours.

The CLO feature may be disabled by selecting the “Disable CLO” option. In this case, nominal driver output current will not change over the LED module life. This is equivalent to having the CLO percentage set to 100% for all 16 data points. By default, the CLO feature is disabled.

The LED module working hours recorded by the driver can be changed or reset to zero by using the “Set LED module working hrs” field. This feature is useful when an LED module is replaced in a driver/LED module system (assume the driver-LED module system has been operating for 5000 hours). If the LED module needs to be replaced with a new one, this feature can be used to reset the working hour count in the microcontroller of the driver. The valid range of values for this field is 0-127500 hours, in increments of 1 hour.
2.5 Over The Life (OTL)
This feature is used to alert the user at the end of the predicted lifetime of the LED module.

The driver maintains count of the working hours of the LED module (the same working hour count is used in the CLO feature). Using OTL, the luminaire manufacturer can define the time at which the end user is alerted to the end of life. This is known as the OTL activation time.

The OTL activation time can be any value between (0-127500) hours in increments of 500 hours. Once the OTL activation time is reached, the driver will flash for 2.5 seconds and then continue normal operation (Figure 9). LED flashing will happen every time at startup once the module’s working hours exceeds it’s OTL activation time.

In the default profile, the OTL feature is disabled.

2.6 Adjustable Startup Time
At power ON, the fast fade-up of light can be unpleasant in certains applications. To avoid such a situation, the driver fade-up time at start-up can be programmed to a value between 1000ms and 30000ms, in increments of 1ms. The default start fadeup time is 1000ms.
3. Driver Specifications

3.1 Input Voltage Range
The nominal input voltage of the driver is 120Vrms – 277Vrms (+/- 10%). The driver is programmed to turn on only after the input voltage exceeds 90 Vrms. After turning on, if the input voltage goes below 90 Vrms, the output power provided by the driver to the LED module will start reducing. The driver will turn off if the input voltage goes below 30Vrms. Please note that the voltages mentioned here are typical values only.

3.2 Driver Output Current, Range and Tolerance
This driver can be programmed to deliver any current between 200mA and 700mA with 10mA steps and will deliver current with 5% tolerance from unit-to-unit over the complete temperature range of the driver(-40°C to 80°C TC). Refer to datasheet for more info.

3.3 Power Factor (pf)
Power Factor is defined as the cosine of the angle between the voltage given to the driver and the current drawn by the driver. The 150W driver has a pf of 0.95 max at max load. For 230Vac input, a power factor >0.9 is achieved over output power >43W (corresponding to output of Vout > 125Vdc and Iout > 350 mA). The 75W driver also has a pf of 0.95 at max load. For 230Vac input, a power factor >0.9 is achieved over output power > 30W (corresponding to output of Vout > 80 Vdc and Iout > 350 mA). (Figures 10 and 11).

3.4 Total Harmonic Distortion (THD%)
Total harmonic distortion is a measurement of the harmonic distortion present and is defined as the ratio of the sum of the powers of all harmonic components to the power of the fundamental frequency. This driver has <20% of THD total and <15% of THD 3rd Harmonic. (Figures 12 and 13).
Efficiency of the driver is defined by the ratio of output power and input power. The 150W driver (when partnered with efficient components) delivers a max efficiency of >93% at max load and efficiency >90% for >50% of power, while the 75W driver delivers a max efficiency of >92% at max load.
4. Thermal Considerations

4.1 LED Module Thermal Protection (MTP)

The driver helps to regulate LED module temperature by regulating current to it. This feature helps protect the LEDs when operated in a hot ambient environment. An NTC (Negative Temperature Coefficient resistor) must be placed on the LED module (Figure 1) and connected to black-white and blue-white wires of the driver. Only two specific NTC part numbers are supported by this driver:

1. 10k NTC - Murata 10k, Part number NCP18XH103J03RB
2. 15k NTC - Murata 15k, Part number NCP15XW153E03RC (with 390 ohms in a series with the NTC)

The luminaire manufacturer can set the temperature at which to activate the MTP feature, defined by MTP warn (value between 50°C - 80°C) and the slope defined by MTP max (55°C - 85°C). Depending on module temperature, the driver current will follow the linear line between 100% and MTP min dim level (default 10%). At the rated operating conditions of the luminaire, the LED module temperature must not exceed MTP warn. This feature is helpful in maintaining LED life during occasional/temporary heat spikes like a hot day or loss of air conditioning. If the LED module temperature exceeds 90°C, the driver will turn OFF. It will then turn back ON when the module temperature reduces to 85°C (5°C hysteresis). The driver does not respond dynamically to changes in parameters - MTP warn, MTP max and MTP min dim level. Hence the driver must be powered down and turned ON for changes in these parameters to take effect.

The driver also has an additional feature to detect if the MTP is missing in the LED module. If module temperature protection is enabled and the NTC is missing, the driver will flash for 10 seconds at startup and then go to the lowest dim level (10%). This feature is available ONLY if 10k NTC is selected. By default, 15k NTC is selected. Therefore, a new, out of factory driver will not flash if NTC is missing.

4.2 Thermal Fold Back (TFB) of Driver

With this feature, the driver will reduce the current to the LED module if the driver itself is heating up due to abnormal conditions. The driver will cut-off the current when the driver case temperature is 5°C above its limit (80°C). (Figure 15).
4.3 Temperature Case Point

To achieve adequate lifetime and reliability, it is critical that the temperature of the components in the driver are within their ratings. In the driver design, all precautions were taken to ensure that the components within the driver are at the lowest possible temperatures. Initial thermal analysis is performed via IR scans at room temperature to identify the hottest components of the driver. Subsequently, detailed measurements of the temperatures of the critical components are performed under various input/output conditions at the worst case operating temperatures. These temperature measurements are related to a Tcase point on the driver as shown in Figure 16. This location of the point is identified in the product label (Figure 17). The temperature of this point can be related to the temperatures of the critical driver components, as illustrated in the following scenario. TC point on these drivers is on the side of the case at the location of pointed arrow.

The worst case self rise for the Xitanium LED Programmable Driver is 25°C; i.e. if the ambient temperature is 55°C, under the worst case operating conditions, the case temperature can be about 80°C. Please refer to the datasheet for the Tcase temperature for other various driver operating conditions.

4.4 Lifetime

This driver is designed to provide a lifetime of 100K hours at ≤70°C TC and 50k hours at ≤80°C TC with min. 90% survivals. See Figure 18 and Figure 20 for more information.
4.5 Reliability and Failure Rate

It is important to have a general understanding of the definitions regarding the lifetime of electronic products. Reliability experts often describe the reliability of a population of electronic products using a graphical representation known as the Bathtub Curve (Figure 19). The Bathtub Curve can be divided into three periods. The first is an initial period of infant mortality, where the defective/weak products fail. This is followed by the normal life of the product with a low and relatively constant failure rate. Following this is the final period of the product lifetime where wear-out mechanisms of the product kick in and failure rates increase.

It is important to understand that the Bathtub Curve does not depict the failure rate of a single item, but describes the relative failure rate of an entire population of products over time. Some of the units will fail during the infant mortality period; others will last until the wear-out period, while a few of the units will fail during the normal life. Reliability deals with random failures in a population of products and is expressed in terms of rates, such as Failures in Time (FIT) or Mean Time to Failure (MTTF). On the other hand, lifetime refers to the length of time that a single product may be expected to function properly before a known wear-out mechanism renders the product unfit to use. Lifetime is typically expressed in hours. For instance, a lifetime of 100,000 hours implies that under normal operating conditions, a typical product would be expected to last for 100,000 hours before failure. On the other hand, an MTTF of 100,000 hours means that in a population of 1000 units, one could expect a random failure every 100 hours. In other words, the MTTF can be expressed as:

\[ \text{MTTF} = \frac{\text{Total Operating Time}}{\text{Number of Failures}} \]
While the lifetime of an LED driver depends on the component that is most likely to fail, the failure rate of the driver depends on all the components within the driver. As mentioned in an earlier section, the MIL-HDBK-217F reliability model is used to predict the theoretical failure rate of Xitanium LED Programmable Drivers. For a typical 150W Xitanium LED Programmable Driver operating at a case temperature of about 50 °C, a theoretical failure rate of 538 PPM/1000 hours and a MTTF value of approximately 1.86 million hours are obtained. Figure 20 illustrates how the number of failures of the LED driver varies with time. Please note that for the calculation, worst-case electrical stresses are assumed to obtain a conservative estimate of the LED driver MTTF. If more realistic values are assumed, higher MTTF values are expected. Also, these calculations assume a typical operating temperature. If the operating temperatures were higher, the stress levels on the driver components would increase leading to increased failure rates.

Please note that the data shown to the left is a theoretical calculation only and by no means can substitute for actual field data. Our past experience has shown that this theoretical prediction is much more conservative than the actual field data. Ongoing field testing indicates much higher survival rates for the same duration under normal conditions.
5. Dimming

5.1 Programmable Dimming Options
This feature of the driver enables the OEM/end user to select multiple dimming options. Dimming can be achieved through the below methods.

5.1.1 1-10V Dimming Interface
This is the traditional way of dimming a driver from 100% to 10% based on dimmer voltage. Note that the 100% level is determined by the current level set by the programmer or by external RSET (AOC feature). The minimum current that can be supplied by the driver is limited to 50mA; so for current settings below 500mA, the minimum allowable dim percentage will be greater than 10% (Figure 21). The user can also set the minimum dim level as shown in Figure 21. For example, if the minimum dim level is set to 50%, the driver output will be 50% for 1-10V voltage of 1V or when the dim wires (violet and gray) are shorted (Figure 22). In some dimming applications, an extra mains wire is used along with an additional control module to switch the driver between two dim levels. Using the feature described above, the additional control module can be replaced by a simple relay.

5.1.2 Dimming Through DALI
DALI is a digital communication protocol popular in the lighting industry. It is an IEC standard and there are many control devices from Philips and other manufacturers that communicate using DALI. The voltage across DALI wires is typically 16V (refer IEC specification for details) and it is polarity insensitive. The DALI wires can be run alongside input main wires and the maximum current on a DALI line is limited to 250mA. The voltage drop between two devices on a DALI network cannot be more than 2V, hence the need to limit the maximum length between two DALI components to 300m.

Using DALI, it is possible to send dimming commands (1-254 levels), set fade rates and fade times, query driver or LED status in addition to other features. This driver also responds to LED-specific DALI commands like query if the LED module is short circuit or open circuit; select between logarithmic or linear dimming curves, etc. For more information on DALI, refer to the IEC specification for DALI protocol.
1. IEC 62386: 102 – General requirements – Control gear
2. IEC 62386: 207 – Particular requirements for control gear – LED modules
5.1.3 Integrated Dynadimmer

Dynadimmer is an external dimming control device developed by Philips that enables a simple, automatic step dimming in a pre-programmed manner. This driver incorporates the Dynadimmer feature within it, hence the name “Integrated Dynadimmer” (Figure 23). This feature allows dimming to predefined light levels based on the ON-time duration of the driver. Its primary use is for outdoor night applications, where the light level may be reduced during non-peak hours. With flexibility in setting time and light levels, the user can configure the driver for specific locations and applications.

Using Integrated Dynadimmer, users can set 5 light levels and associated time frames. The driver does not have a real time clock. Instead it calculates a “virtual clock time,” determined by the duration of operation of the driver in the night. After 3 valid “ON-times,” the driver will be able to calculate the virtual clock time. A valid ON-time is defined as the time for which driver operates continuously for \( \geq 4 \) hours and \( \leq 24 \) hours. As shown in Figure 24, after learning driver ON-time for 3 consecutive days, the dim profile takes effect from the 4th day onwards.

For more information on Dynadimmer scenario’s please check chapter 14.

### Figure 23: Dimming Interface Selection (DIS)

<table>
<thead>
<tr>
<th>Override</th>
<th>Disable</th>
<th>Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Netherlands</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dim Level</th>
<th>110</th>
<th>100</th>
<th>90</th>
<th>80</th>
<th>70</th>
<th>60</th>
<th>50</th>
<th>40</th>
<th>30</th>
<th>20</th>
<th>10</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAY 1: 12 hours</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DAY 2: 12 hours</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DAY 3: 12 hours</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DAY 4: 12 hours</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DAY 5: 12 hours</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Figure 24: Learning mode

5.1.4 Dynadimmer Override

In some instances, there is a need to override the Dynadimmer dim cycle either manually or automatically. For example, luminaires in a parking garage may be configured to utilize the integrated Dynadimmer feature with a defined dim cycle. A motion sensor can be associated with one or more luminaires which, when activated by passing cars, can signal the driver to override the dim cycle and go to full light output. When the Dynadimmer Override function is
enabled and the 1-10V wires are shorted, the driver will override the active dim cycle and go to full light output. The driver will return to normal Dynadimmer dim cycle when the 1-10V wires are open.

As shown in Figure 25, the 1-10V wires function as a switch in the Dynadimmer override mode.

Figure 26 depicts the voltage threshold necessary to activate the override functionality and the hysteresis margin.

### 5.1.5 AmpDim

AmpDim is a programmable feature integrated in the driver. It enables cabinet based intelligent dimming without the need for additional control wires or infrastructure changes. A cabinet controller signals to the driver to lower the light output via a reduction in the amplitude of the mains voltage. The intelligence embedded in the LED driver allows for a pre-programming of multiple dimming levels based on the amplitude of the mains voltage. Historically, mains dimming was used on magnetic ballasts to dim conventional lamps. By lowering the mains voltage, a proportionate reduction in light output was achieved. Until now electronic ballasts were not able to replicate this function.

In order to program AmpDim (available only in the Xitanium Prog+ drivers), please use Programming Software V1.5 or later. The latest version of the software can be downloaded from the OEM website at www.philips.com/xitanium.

The default range of AmpDim is 170V – 220V. The range can be customized via the programming interface. The user can choose the Start Voltage, Start Percent, Stop Voltage, and Stop Percent. Figure 27 shows an example of the AmpDim programming interface.

Important:
- There needs to be a minimum of 20V difference between Start and Stop Voltage settings when programming the driver.
- There must be a minimum change of 5V in the mains voltage before the driver starts dimming. This prevents accidental dimming due to small fluctuations in the mains voltage.

Please refer to below table for complete parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Min</th>
<th>Max</th>
<th>Increments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Voltage</td>
<td>170V</td>
<td>250V</td>
<td>1V</td>
</tr>
<tr>
<td>Stop Voltage</td>
<td>150V</td>
<td>230V</td>
<td>1V</td>
</tr>
<tr>
<td>Start Percent</td>
<td>30%</td>
<td>100%</td>
<td>1%</td>
</tr>
<tr>
<td>Stop Percent</td>
<td>30%</td>
<td>100%</td>
<td>1%</td>
</tr>
<tr>
<td>Start Voltage - Stop Voltage</td>
<td>20V</td>
<td>100V</td>
<td></td>
</tr>
</tbody>
</table>
6. Inrush Current

“Inrush current” refers to the input current of short duration that flows into the driver during the initial start-up to charge the capacitors on the input side. Typically, this is a short duration current, whose amplitude is much greater than the operating or steady-state current, as illustrated in Figure 28.

The experimental setup for measuring the inrush current of the Xitanium LED Programmable Driver is shown in Figure 29. For the test setup, a line impedance comprised of 645 mΩ and 22 μH (nominal values) is used. For the measurements, an input dc voltage equal to the peak of the corresponding line voltage is applied (via the capacitor bank). The measured results for a single Xitanium driver are shown in the chart below.

On a system with an ABB S261 B16 miniature circuit breaker, eleven Xitanium LED Programmable Drivers can be connected in parallel. Please note that the inrush current does not increase proportionally with the number of drivers connected in parallel; i.e. for “N” drivers connected in parallel does not equal “N” times the inrush current for one driver. The line impedance also has a significant effect on the peak and duration of the inrush current as illustrated by the simulation results in Figure 30.

In many drivers, an NTC is added in series with the input to limit the inrush current. The NTC offers an initial impedance to the inrush current. In the steady-state, as the NTC heats up, its resistance reduces and therefore, there is minimal voltage drop across it. The simulation results in Figure 31 illustrate that using an NTC can reduce the amplitude of the inrush current; however, the time duration of the current spike increases.

### Table 1: Inrush Current Results for Single Xitanium Driver

<table>
<thead>
<tr>
<th>Vin (Vrms)</th>
<th>Number of Drivers = 1</th>
<th>Rine (645 mΩ)</th>
<th>Lline (22 μH)</th>
<th>Vin (Vrms)</th>
<th>Number of Drivers = 11*</th>
</tr>
</thead>
<tbody>
<tr>
<td>120Vrms</td>
<td>58</td>
<td>140 μs</td>
<td>120Vrms</td>
<td>210</td>
<td>320 μs</td>
</tr>
<tr>
<td>230Vrms</td>
<td>108</td>
<td>140 μs</td>
<td>230Vrms</td>
<td>408</td>
<td>320 μs</td>
</tr>
<tr>
<td>277Vrms</td>
<td>126</td>
<td>140 μs</td>
<td>277Vrms</td>
<td>490</td>
<td>320 μs</td>
</tr>
<tr>
<td>305Vrms</td>
<td>142</td>
<td>140 μs</td>
<td>305Vrms</td>
<td>540</td>
<td>320 μs</td>
</tr>
</tbody>
</table>

* Based on simulation results

### Table 2: Inrush Current Results with NTC

<table>
<thead>
<tr>
<th>Vin (Vrms)</th>
<th>Number of Drivers = 1</th>
<th>RNTC: 0 Ω</th>
<th>RNTC: 2.5 Ohm*</th>
</tr>
</thead>
<tbody>
<tr>
<td>120Vrms</td>
<td>58</td>
<td>140 μs</td>
<td>120Vrms</td>
</tr>
<tr>
<td>230Vrms</td>
<td>108</td>
<td>140 μs</td>
<td>230Vrms</td>
</tr>
<tr>
<td>277Vrms</td>
<td>126</td>
<td>140 μs</td>
<td>277Vrms</td>
</tr>
<tr>
<td>305Vrms</td>
<td>142</td>
<td>140 μs</td>
<td>305Vrms</td>
</tr>
</tbody>
</table>

* Based on simulation results
7. Surge Protection

<table>
<thead>
<tr>
<th>Exposure</th>
<th>Minimum open-circuit voltage to be applied to SPD</th>
<th>Current to be driven through the SPD</th>
<th>Optional test</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>6 kV</td>
<td>3 kAc</td>
<td>6 kV</td>
</tr>
<tr>
<td>High</td>
<td>10 kV</td>
<td>10 kA</td>
<td>6 kV</td>
</tr>
</tbody>
</table>

Notes:
1. The scope of these tests is limited to SPDs, in contrast with all the other recommended tests that may be applied to equipment other than SPDs.
2. Values shown for the current are applicable for each phase of the SPD. In contrast with a test applied to equipment for the purpose of assessing its response to the surge environment, a test applied to characterize the performance of an SPD requires that the specified current be driven through the SPD. For the low exposure, this can be accomplished with a typical Combination Wave generator. For the high exposure, two separate generators, in two successive tests, must be used to apply the specified values.
3. For low exposure tests, if a Combination Wave generator is used instead of two separate generators, the generator charging voltage has to be adjusted to obtain the stated current amplitude.

7.1 Protecting LED Drivers in Accordance with IEEE / ANSI C62.41.2 Transient Surge Requirements

The IEEE/ANSI C62.41.2 standard gives guidelines for recommended surge protection levels for indoor and outdoor electronic equipment connected to the mains power lines. For outdoor applications, the standard calls for a recommended surge protection level of 6kV 3kA for low exposure conditions and, 10kV, 10kA for high exposure conditions as shown in Table 4 (taken from the C62.41.2 standard).

Figure 32 gives an explanation of the Location Categories used in the standard - note that Category C includes outdoor mounted equipment. Within Category C, there are 2 exposure levels defined: Low and High. Whether the “Low” or “High” level should be used depends on the application and location of the installation. For example, pole-mounted roadway lighting would typically fall into the more severe High Exposure level of Category C.

Protecting electronic equipment for Category C, high exposure levels, can be challenging for a number of reasons. Typical lighting components such as LED Drivers requires a hi-pot test according to UL or other regulatory guidelines to ensure proper isolation of the housing of the driver to the input wires. The hi-pot test voltages depend on the overall voltages seen in the system or mains wires (whichever is higher) and are typically 2kVac to 4kVac. During the hi-pot testing, the measured leakage current is required to be low (<10mA). The peak voltage of a 3kVac hi-pot test is 3kV\times\sqrt{2} = 4.2kVpk. The reason this is an important consideration is that it restricts the use of common MOV or other surge suppression devices between earth ground (G) and any of the input wires (Line-L, or Neutral-N). However, UL does allow these types of surge suppression devices to be installed after performing the hi-pot testing. This is an important consideration as it is not always practical to add such a suppression device after hi-pot testing at the LED driver level, while it is quite practical to install these devices in the fixture. In the following sections are recommendations on how to implement such suppression devices, how to select them properly and what considerations should be taken.
7.2 Choosing the correct suppression device

An LED driver without external protection TVSS (transient voltage surge suppression) is designed to handle surges in the 2-3kV range for the 1.2/50usec combi-pulse (2ohm). To achieve a system protection level of 10kV, 10kA, the external TVSS device must be able to limit the voltage that appears at the driver terminals (L, N, G). To protect for a 10kV, 1ohm surge (10kA), the required clamping voltage of the external MOV (or other TVSS) needs to be lower than 1kV at 8kA \((10kV-2kV)/1ohm=8kA\). To select the proper device, MOV (or TVSS), datasheets should be reviewed to find the appropriate clamping level.

7.2.1 What to look for in the MOV ratings

1) AC current rating: This needs to be sufficiently higher than the normal operating voltage range. For an LED driver that is rated 120-277Vac, a 320Vac rating is recommended. For LED drivers that are rated to 120V only, a 150Vac rating is recommended.

2) Maximum surge rating: A 10kA rating is required for the C62.4.1.2 high exposure level. 20mm diameter MOVs can typically be found with this rating.

3) Appropriate agency approvals: UL, CE, etc., as required.

7.2.2 Connecting MOVs in the fixture

1) Connect 1 MOV between Line and Ground.
2) Connect 1 MOV between Neutral and Ground.
3) Connect 2 MOVs in parallel between Line and Neutral. Testing has shown that by connecting 2 MOVs in parallel between Line and Neutral improves the differential mode surge capability significantly.

Testing still needs to be completed to confirm that 10kV, 10kA surges can be tolerated for the system with this configuration. See Figure 33.

7.3 Why not design a driver to survive 10kV directly without clamping to earth ground?

In theory, it’s possible to design a driver with sufficient spacings internally to survive a 10kV surge voltage from lines to case (ground) without clamping the voltage so that hi-pot testing is not affected. This concept was implemented on some electronic HID products (Philips Cosmopolis). However, in a typical LED system, the LEDs are mounted to a heat sink which is connected to earth ground for thermal reasons. A common mode surge voltage of 10kV would break over the insulation between the LEDs and the heat sink in most installations and, therefore, voltage clamping is required. The typical break down of the LEDs to the heat sink is in the order of 2kV, so clamping below this level is necessary even if the driver is designed to handle the higher voltages. This is why a driver design that can handle 10kV surges does not help the system pass 10kV. The voltages must be clamped to a level that the LED to heat sink insulation can safely withstand to prevent LED failure. Also, not clamping the common mode surges would put a large burden on the wiring inside the fixture as everything would need to be designed to withstand 10kV (wires, connectors, wire nuts, etc.). Implementing the above suppression circuit in the fixture eliminates the need for it to withstand high voltages on the wires, connectors, and the LED to heat sink interface.
8. Leakage Current

The Xitanium LED Programmable Driver is designed to meet leakage current requirements per IEC 61347-1 and UL 8750. This translates into 0.7 mA peak per IEC and 0.75 mA rms per UL. The test is done with the driver alone. Typical measurements are 0.45 mA pk (per IEC 61347-1) and 0.5 mA rms (per UL 8750). Within the luminare, leakage current can be higher since the LED load introduces additional capacitance to the fixture. As such, precautions should be taken at the luminare level and also if two or more drivers are used in a luminare.

9. Electromagnetic Compatibility (EMC)

Xitanium LED Programmable Drivers meet EMC requirements per CISPR 15 ed 7.2 and FCC Class A. These tests are conducted with a reference setup that includes a driver and an LED load/heat sink combination mounted on a metal plate. To maintain good EMC performance at the luminare level, consideration should be made to keep input, output and control wires as far apart as possible. Addition of ferrite beads in series with the wires or coupling the wires through ferrite cores within the luminaire will improve the overall EMC performance. However, selection of the type and characteristics of the additional filter depends on what frequency components have to be damped and by how much.

10. Electrical Isolation

The Xitanium LED Programmable Driver has basic isolation from the primary to the secondary side and double isolation between all the electronic circuits and the chassis. Figure 34 illustrates the isolation scheme for the Xitanium LED Programmable Driver.
The Xitanium LED Programmable Drivers meet safety standards according to
the IEC 61347-1 standard. In accordance to this standard, the following safety
requirements are met (Figure 35):

• Basic isolation between the Primary and Secondary side wires:
  - Driver output voltage < 1000VDC
  - Insulation test voltage: 1000V + 2 X 305 (≈ 1750V)
• Double isolation between all the wires and the chassis:
  - Insulation test voltage: 3750V

The table below lists the isolation voltages between the various wires and also
from the wires to the chassis of the driver:

<table>
<thead>
<tr>
<th>Isolation</th>
<th>Input Wires</th>
<th>Output Wires</th>
<th>DALI Wires</th>
<th>0-10V Wires</th>
<th>Chassis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Wires</td>
<td>NA</td>
<td>1750</td>
<td>1750</td>
<td>1750</td>
<td>3750</td>
</tr>
<tr>
<td>Output Wires + Fortimo Interface Wires</td>
<td>1750</td>
<td>NA</td>
<td>1750</td>
<td>1750</td>
<td>3750</td>
</tr>
<tr>
<td>DALI Wires</td>
<td>1750</td>
<td>1750</td>
<td>NA</td>
<td>NA</td>
<td>3750</td>
</tr>
<tr>
<td>0-10V Wires</td>
<td>1750</td>
<td>1750</td>
<td>NA</td>
<td>NA</td>
<td>3750</td>
</tr>
<tr>
<td>Chassis</td>
<td>3750</td>
<td>3750</td>
<td>3750</td>
<td>3750</td>
<td>NA</td>
</tr>
</tbody>
</table>

All of the wires in the Xitanium LED Programmable Driver meet the UL1452
safety standards. As an additional safety precaution on the luminaire level, it is
advised to not route the input wires, output and Fortimo Interface wires, DALI
and 0-10V wires through the same conduit if no additional isolation is provided
between these sets of wires.

11. IP Rating

The Ingress Protection (IP) rating of electronic device is covered as part of NEMA
IEC 60529 standard and specifies the degree of environmental protection that an
enclosure provides. The IP rating has two numbers, which specify the following:
1. Protection from solid objects or materials
2. Protection from liquids

The Xitanium LED Programmable Driver has an IP66 rating which means that:
• The driver is totally protected against dust
• The driver is protected against temporary flooding of water, e.g. for use on ship
  decks where limited ingress is permitted

Xitanium LED Programmable Driver testing is done in an externally certified
laboratory using their standard test procedures.
12. Programming

Figure 36 shows a typical wiring diagram of the driver. The violet and violet-white wires are the DALI programming wires. They need to be connected only during the programming process. If not in use, they can be left open. Since the driver uses DALI for communication, it must be powered ON when reading or programming driver settings. Also, with DALI being polarity insensitive, the violet and violet-white wires may be interchanged when connecting to a DALI controller.

In order to program any feature in the Xitanium Prog+ drivers, please use Programming Software V1.5 or later. The latest version of the software can be downloaded from the OEM website at www.philips.com/xitanium.

12.1 Frequently Asked Questions

Q. Can multiple drivers be programmed at the same time?
A. No. Only one driver can be programmed at a time with the Xitanium LED driver programmer. This PC application interface is intended to be used during luminaire assembly (one driver and LED module per luminaire). The driver is designed to use the standard DALI protocol with memory banks. When installed in the field and a telemanagement system has assigned DALI addresses to each of the drivers, it is possible to program more than one driver at a time. The telemanagement system only needs to be aware of the DALI memory bank locations of the driver parameters.

Q. How much time does it take to program settings in the driver?
A. Depending on the selected features to program, the programming time varies between 2-15 seconds.

Q. My computer does not have a serial port, but it does have a USB port. Can I use USB port with this application interface?
A. Yes. The Xitanium LED driver programmer currently only supports serial to DALI converter, but there are many USB to serial converter cables available in the market. These converters, when installed, create a virtual COM Port. The following sequence of steps can be used to identify the COM port number created by the USB to serial converter:

1. In the “Start” menu, right click on the “My Computer” icon and then click on “Properties.” (Figure 37).
2. In the “System Properties” window that appears, click on the “Hardware” tab. (Figure 38).
3. Click on the “Device Manager” button. (Figure 39).

4. In the “Device Manager” window that appears, expand the “Ports (COM and LPT)” tree list. Select the USB to serial device that was earlier installed, then right click and click on “Properties.” (Figure 40).

5. In the pop-up window, select the “Port Settings” tab and click on the “Advanced” button. (Figure 41).
6. The COM Port Number assigned by the USB-to-serial converter is shown in the bottom of the window as shown in Figure 42.

7. The Xitanium LED driver programmer supports COM port numbers from 1 to 7. Select a port number in this range by expanding the COM Port number list box. (Figure 43).

8. Make a note of the selected COM Port Number. Run the Xitanium LED driver programmer. Click on the “Port Setup” button at the bottom of the screen. Select the Port Number as noted earlier and click on the “Close” button (Figure 44). The PC application interface is now configured for the new COM Port.
13. Profiles

13.1 Saving a Profile

Once settings for a driver have been defined using the PC application interface, the user can save it to a file on the computer using “File-> Save” option (Figure 45). The file is saved in “comma separated value” or .csv format.

The Notes field at the bottom of the screen can be used to store details about the profile. This information is stored only in the .csv file and not in the driver. (Figure 45).

13.2 Loading a Profile

A previously saved profile can be loaded by using the “File->Load” option. The installation folder of the Xitanium LED driver programmer also contains a default profile—“XitaniumOutdoorDriverProfileDefault.csv.” Programming with this profile restores the driver to its factory default setting (Figure 46).
13.3 Selective Programming

In the PC application interface, it is possible to select only a specific feature to be programmed. For example, if the user would like to only change the module current, then only the AOC feature can be “checked” while other features can be “unchecked” (Figure 47). The unchecked features will not be programmed and hence, using this feature the programming time is shortened.

13.4 Version Management

The driver software version can be checked by using Tools->Version option. Version 1.4 and above also checks driver compatibility automatically and enables applicable features corresponding to the driver version. The user can also manually select the driver version using “Select driver version” list box. For example if the user selects “150W V02E01 or 75W V01E01,” the 15k NTC option and OTL feature will be disabled since they are not available. If the version check is enabled, the interface will always check driver compatibility when communicating with the driver (Figure 48). The manual selection is useful when the user does not have the latest driver, but would like to enable the latest features and save a profile. One of the drawbacks of checking driver version is longer programming time.

To shorten the process, version check can be disabled by unchecking the driver version check option in the “Version and Manufacturing information” dialog.
13.5 Factory Programmer

To mitigate error during factory programming, a “Factory version” of the programmer is also available. In this version, all fields are disabled apart from the “Read” and “Program” options. When a profile is loaded and the user clicks “Program,” the name of the profile filename will appear after a successful/failed program operation at the bottom of the screen. The profile filename will appear only after a “Load-profile->Program” sequence. (Figure 49). A read operation will clear the profile filename property, and a subsequent program operation will not show the profile filename upon completion. In this way, a user will always know that if the program parameters are the same as the profile loaded. When the user clicks “Read,” the message “[Read-out: settings]: PASS/[FAIL]” will appear at the bottom of the screen (Figure 50).

![Figure 49: Factory version of programming interface (Program)](image1)

![Figure 50: Factory version of programming interface (Read)](image2)
14. Integrated Dynadim Working Scenarios

14.1 Synchronization to Change in ON-Time Duration

There are two possibilities when there is a change in ON-time duration between successive dimming cycles. Following are two examples.

14.1.1 Case 1

When the change in ON-time is greater than 1 hour:

Similar to the learning mode explained in Figure 6, the driver will need 3 cycles to learn the new ON-time duration and synchronize with Dynadim schedule setting. Figure 51 shows this scenario, where the ON-time cycle changes from 8 hours to 5 hours (8-5= 3 > 1 hour).

14.1.2 Case 2

When the change in ON-time duration is less than or equal to 1 hour:

This represents normal operation, wherein the driver averages the last 3 ON-times and calculates the virtual clock time. The dimming schedule stays active while gradually adapting to the new ON-time. Figure 52 and 53 show the sequence of events as the ON-time changes from 14 to 13, and finally 12 hours.

14.2 Scenario 1: Input Mains Power Interruption

If the input mains power drops to 0V for more than 1 second, the driver will record it as a turn OFF event and will try to re-calculate the virtual clock time again when mains power is restored. This only means that the driver will need to synchronize to regular ON-time duration. (See previous section - Synchronization to change in ON-time duration).

On the other hand, if the duration of a mains power drop to 0V is less than 1 second, energy to sustain the microcontroller operation within the driver is not lost and hence the Dynadim dimming cycle remains unaffected.

14.3 Scenario 2: Input Mains Power Dip

The driver is robust enough to handle an input mains power dip to 25V for 1 minute. As expected, light output will reduce for the duration of the mains dip, but the dimming scene cycle will not be affected.
14.4 Scenario 3: Input Mains Power OFF for Maintenance or Temporary Power Outage

This scenario is illustrated in Figure 54. The driver will go to full 100% light output for the subsequent cycle after a power outage and then continue with regular dimming schedule.

14.5 Scenario 4: Programming a New Dimming Schedule

A new dimming schedule can be programmed any time the driver is powered ON. The new dimming schedule takes effect immediately after programming (Figure 55).